Presenting ...

Fact Based Management Tools®
Module: SPC / EPC / Six Sigma

Version 7.2 for Windows XP and later editions.
Computer Software for

Statistical Process Control (SPC), Engineering Process Control (EPC), and, Six Sigma Process Improvement

In this simple demo, our software is presented in the form of a series of screen-shots. It would give
you the feel of how the actual software works and looks like.

Narrative is on the bottom panel of each slide. Concepts and features are explained through two
enlightening six sigma projects (one from service industry and one from manufacturing industry).

Please press ‘Enter’ or ‘Arrow’ keys on the keyboard to browse the slides at your own pace.



Process Improvement using SPC / EPC / Six Sigma Tools

There is a pressing need for the continual improvement of manufacturing and service processes in
today’s competitive business environment.

You may follow the time-tested Six Sigma DMAIC approach (Define, Measure, Analyse, Improve,
and, Control) in any improvement initiative.

For this, you need to ...
1. Identify the areas for improvement
2. Identify the key input & output variables (KIVs & KOVs) that are critical to quality/schedule/cost

3. Collect the relevant data and analyse them using the SPC tools such as C&E Diagram, Pareto,
Histogram, Scatter Plot, Control Chart, etc.

4. Take corrective and preventive actions to improve the process, and

5. Install an on-going control scheme (such as SPC or EPC chart) to sustain the improvement.



What is SPC ?

Statistical Process control (SPC) is a scientific and inexpensive way to prevent defects. It is an
effective check against assignable causes of process variation. You would require SPC tools for
every Six Sigma project.

When to use EPC ?

Once a process is brought to stable condition using SPC charts, Engineering Process Control
(EPC) helps in predicting the process performance and pro-active adjustments, thereby reducing
process variability. It adds extra power to your process control schemes.

Both SPC and EPC are very essential for achieving the PPM (parts per million) defect levels
expected of your Six Sigma initiatives.

In this context, it is very important to provide a statistical software to your personnel for
error-free data analysis and charting on regular basis.

Our FBM Tools — SPC/EPC/Six Sigma module is a Windows-based computer program designed
specifically for improvement projects, by seasoned Engineer-Statistician experts (alumni of the
Indian Statistical Institute).

Before getting into the details of the software, let us look at one example project from service
industry and one from manufacturing industry, to learn how to put SPC/EPC/Six Sigma tools to use.

Please see the software screens and read the narrative at the bottom panel.
e



@] six Sipma Project Information Database

Froject ID: |F"DDIZIIZI:2 <-Enter aunique |D.  Project Status:

Feasan for Project: |Err|:|rs in 8/t records

Project Title: |Ac:|:|:|unts Data Qualty Improwvement

Froject Ohjective: |TEI reduce errors in accounts data.

Froject Description:

Project Leadear: |5J{E‘L”|E‘-‘f‘J':'hn Joh Title: |Manager

Wiew / Edit the List of Team Members | Wiew / Edit the Ligt of Key Input and Output Y aniables [K"s and K.OV's]

EMyPrqumséT 1. Define T 2. Measure T 3. Analyse T 4. Improwve T 5. Contral T Fesults

FrojectlD |Proiecﬂ'itle |F"ru:nieu:ﬂ]bieu:1ive | ProjectBeason |F"r|:|ieu:1Desc:riptiDn| PruiedLeaderUserlD| Projed
P00 Tablet *Weight Contral | Ta reduce weight wariat Rejection due to weight| Thiz iz for an-gaing SPC stanlzy Stanlay

Accounts Data Quality || To reduce erors in accd Erors in a/c recaords _ stanley Stanley .

[«] |

Add MNew Record Save f Update Delete Record Fefresh
4] 4 |2af2

Example Project (Service Industry)

In a certain company, there were chronic data entry problems in the Accounts Department. As part
of its Six Sigma initiatives, the company’s management has decided to study the data entry errors
by collecting the data for one month and analysing it. The company has designated its Manager,
Mr. Stanley John as the Project Leader.

Mr. John has created a project record by going to the menu item File > Manage My Projects



@ Data Editor

ChDocuments and Settingshws\Desktop\SPCYY Demo DataiPri2_data.fts
Col 001 Col 002 Col 003 Col 004 Col 005 Col 006 Col 007 Col 008
Date Total Mo. of Records  |Mrong Posting Incorrect Figures Chegue Details Missing  |Forex Conwersion Error - |Spelling Mistakes | TOTALERRORS

M-Aug-2011 1236 3 n 1 7
02-Aug-2011 |563 Z
03-Aug-2011 615
04-Aug-2011  [1367
05-Aug-2011 {231
06-Aug-2011 |B53
08-Aug-2011 |532
09-Aug-2011 (931
10-Aug-2011  [B51
11-Aug-2011 |874
12-Aug-2011 679
13-Aug-2011 652
16-Aug-2011 |54
17-Aug-2011 |535
18-Aug-2011 |786
19-Aug-2011 675
20-Aug-2011 |956
22-Aug-2011 482
23-Aug-2011 |Eek
24-Aug-2011 |h47
2h-Aug-2011 |756
26-Aug-2011 |537
27-Aug-2011 |765
29-Aug-2011 |425
I-Aug-2011 |765
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Append Row ‘ Save f Update | Insert Row Abowe ‘ Delete Row Column Operations Refresh Close

4| 4 [Record: 1 ** Please do not edit row numbers. Software manages it by iteelf, =

Example Project (Service Industry)
Then he created a new data file by going to the menu item File > New Data File.

After that, he entered the data collected in August 2011 and saved the file.



@] Data Analysis Work Book: Pareto Analysis

Six Sigma Project D | Faoooz j Froject Phase:

bdain Title: |A|:|:|:|unts Data Error Analysis

Sub Title: |(Periud: 1-31 August 201713

Data File Mame: |Prj2_data.ﬂs Browse | “iew Datafile

Legend Marme: |Cleri|:al Error Data Unit: |N|:|s

Legend Row Mo: 0 v Diraw Colourfilled Bars

Diata Columns: Fram |3 To |? [ ApplyWeightage

Data Rows : Fram |1 To |25 “WWeightage Row MNa:

Decimal places in output: |_2 <- Otad

General Motes:

Mame of Process: |A|::|::|:|unts Data Entry

Mame aof Anakest: |Stan|ey John

START AHALYSIS NOW |

Add Mew Record | Goto Workbook 1D -» H | Deleta | Refresh | Close |

4] 4 |workbook ID: 2 [Tatal 1 recards) k(M

Example Project (Service Industry)

Looking at the data, he decided to first carry out a Pareto Analysis.

For this he went to the menu item File > Manage My Workbooks / Start Data Analysis » Pareto
Analysis and created a workbook record.



Pareto Diagra x|

Project D POOOOZ Stage: Analyse

Accounts Data Error Analysis

(Period: 1-31 August 2011)
Legend: Clerical Error {Mos)

Pareto Diagram

% Contribution Rank Legend
100 01 Chegue Details Missing
02 Speling Mistakes
a0 0F Wirang Posting
04 Incarrect Figures
20 05 Forex Conwversion Error
|
[il]
a0
40
30
20
i _
“ L

n 02 03 04 05
Rank
Total (Wweighted) = 146.00 (Nos)

05-Sep-2011 16:06

XVZCOMPANY, TRIVANDRURM, IND 18 - 625005,

Example Project (Service Industry)

When he clicked on the ‘START ANALYSIS NOW’ button, the software has displayed the Pareto
Diagram.



Pareto Table Q
FProject ID: POO00O2 Stage: Analyse
Accounts Data Error Analysis
(Period: 1-31 August 2011)
Legend: Clerical Error (Mos)
Pareto Analysis Table
Rank Legend Name Legend Total Weightage Wtd. Total Contribution % Cumulative %
01 Cheque Details Missing 50.00 1.00 50.00 3425 34.25
In] Speling Mistake 2400 100 2400 390 £7 53
03 Wrong Posting 3300 1.00 33.00 2260 80.14
04 Incorrect Figures 16.00 1.00 16.00 10.96 91.10
04 Faorex Conversion Errar 13.00 1.00 13.00 g.90 100.00
GRAND TOTALS : 146.00 146.00 100.00
05-Sep-2011 16:08
NAZCOMPANY, TRIANDEUR, INDIS - 625005,

Example Project (Service Industry)

And, when he clicked on the ‘View Table’ button, the Pareto Table was shown as above.

He has decided to present this Pareto output along with a Cause & Effect Diagram to the
concerned data entry operators for further brainstorming and improvement.



@] Data Analysis Work Book: Cause and Effect Diagram

Six Sigma Project ID: |PUDDDE j Froject Fhase:

Display Marme of Tool: |Cause and Effect Diagram j

hdain Title: |Ac:c:|:|unts Data Errar Analysis

Sub Title:  |(Period: 1-31 August 2011}

Cause(s):| ©Cause1l: | Couse2 | Cause3 | Caused | Couseb5 |  Causeb

Main Cause 1: ‘Peuple Contribution % 56.85
Sub Cauze Legend(s]: Cantribution %

1. |Wrong Puozting 228

2 |Spelling Mistakes 23.29

‘]
5|

0
0

|
|
3 |Incnnect Figures | 10.96
|
|

|Ac:c:uunts Data Errors

[v Report contribution % for Main Cauzes

[v Report contiibution % for Sub Causes also

Decimal places in output: ’_2 < Otad

Process: |Ac:c:|:|unts Data Entry

/|
Analyst.  |Stanley John START ANALYSIS NOW |

Add New Record ‘ GDtDWDrkaDk|D->‘ Sawve f Update Delete ‘ Fefrash | Close |

| o |*workbook 1D: 1 [Tatal 1 records) b (M

Example Project (Service Industry)

He has also decided to group the errors under six categories (variation of Six M’s) such as People,
Method, Equipment, Resources, Measurements, and, Materials.

He went to the menu item File » Manage My Workbooks / Start Data Analysis » Cause and Effect
Diagram and created a workbook record.




and Effect Diagra X]

Project ID: FOOO0OZ Stage: Analyse

Accounts Data Error Analysis

(Period: 1-31 August 2011)

Cause and Effect Diagram

People (56.85 %) Method (43.15 %) Equipment (0.00 %)

Incorrect Figures (10,96 %)

Spelling Mistakes (23.29 %) Farex Conversion (8.90 %)

EFFECT

Wirong Posting (22 60 %) Accounts Data
> Errors

Cheque Details (34.25 %)

/ / /

Materials (0.00 %) | Measurements (0.00 %) Resources (0.00 %) ‘

08-Sep-201116:27

EVZCOMPANT, TRIVANDRUR, INDI8 - 625005,

Example Project (Service Industry)

When he clicked on the ‘START ANALYSIS NOW’ button, the software has displayed the Cause &
Effect Diagram.




®] Data Analysis Work Book: SPC Charts and Histogram

Six Sigrma Project 1D |PEIEIDI]2 j Project Phasze:

Analysis Title: |A|:|:Dunts Data Error Monitoring

SubTitle: |[Peri|:|d: 1-31 August 20171)

Characteristic (v |Cleri|:al Errars Measurement Unit: ‘Nusfﬁecurd
Basic SPC Chart: Diefects/Init {u) = CURRY TSR Conentional

(el lale =W NS Sitop when 255 samples are dropped —' W Diraw contral charts with colour hands

Data Input T Specifications T SFC Farameters T EFC Farameters T Frocess Info.

Data File |Prj2_data.fts Browse | “iemy Datafile

Data Columns:  From 8 To a8

Data Rows Frarm 1T To | 25

Sample Size Column: 2 <-for p, np. and u charts only.

Mominal Yalue Column: <~ far zhart run chart type only,

Decimal places required in numeric output: |_4 <- between 0 and 3 only.

Option for Control Chart Limits: [ rEe z | START ANALYSIS Now |

Add New Record | Goto Workbook 1D -> ‘ Sawve f Update | Delete Refresh| Close

4] A |""arkbook [D: 1 [Tatal 2 recards) bM
Example Project (Service Industry)

Also, the project leader wanted to get an estimate of the current levels of Six Sigma Metrics of the
data entry process. For this, he has decided to open a control chart workbook and use the u-chart.

To setup u-chart, the project leader has gone to the menu item File > Manage My Workbooks /
Start Data Analysis » Control Chart and Histogram and created a workbook record.



FBMTools - SPC [/ EPC [ 5ix Sigma Module

' L
: 1 ‘) Data file read in successfully, You may now open the conkrol chart relaked reports and graphics from the menu bar,

Example Project (Service Industry)

When he clicked on the ‘START ANALYSIS NOW’ button, the software has displayed the above
message.

To view the control chart, he has gone to the menu item Graphics > Control Charts and clicked
open the menu.




Project ID: POO002 Stage: Analyse

Accounts Data Error Monitoring

gt m ol 4 D4 A MY
IFENOU. T=o T AUgUSL ZUTH

]

Characteristic: Clerical Errors (Mos/Record)

u-Chart

ucL

VAN ARRAZYAY

0.0159

0.0005 LEL

1" 13 15 17 19 21 23 25
Q-'inlpln Number 05-Sep-2044-13-50

ArZCOMPANY, TRIVANDRUR, IND 1 - S25005.

Example Project (Service Industry)

The following control chart (u-chart) was displayed.

As the sample sizes were varying, the chart was drawn with varying control limits (not as straight
lines). Areas within control limits shown in green colour, and areas outside limits in red colour.



@] Query / Report: Control Chart Data Analysis Summary
sections to be included . ¥ Basic Statistics
[ Data Homogenisation
[ Cantral Limits

[ Process Capability Indices (Cp/Cpkf..)

W Six sigma Metrics

Femarks [Optional]:

Example Project (Service Industry)

To view the Six Sigma metrics, he has gone to the menu item Reports > Control Chart Data
Summary and clicked open the menu as above.

After checking the required sections in the report, he hit the ‘View/Print’ button to view the report.




E Control Chart Data Summary

@ Zoom |100%

Control Chart Data Summary

General Information
Project ID

Project Stage

Process Name

Analyst Name

Bazic SPC Chart Jelected

Chart Type

Basic Statistics

From Original Data:

Humber of Records Analysed
Sample Size (n)

Grand Awverage

Mawimum Walue

: rOOOOZ

T Analyse

: Adccounts Data Entry
: Stanley John

: Defects/Unit (u)

: Conwventional

HE
@ Varying Sample 3ize
: 0.0082

: 0.01&6

Minimum Walue

Six Sigma Metrics
Defects Per Million (DFM)
Sigma Quality Lewel

Tield (%)

= 0.0000

: §l86.1508

: 3.9020

: 99,1547

Example Project (Service Industry)

Having done the preliminary data analysis, it is now time for brainstorming and improvement.




Example Project (Service Industry)

Brain Storming & Improvement:

Looking at the Pareto Analysis, Cause & Effect Diagram, and the Control Chart, the data entry
operators as well as the project leader agreed that the root causes of the problem were:

1. People (Human errors — spelling mistakes and wrong postings), and

2. Method (Procedural flaws in communicating cheque details)

It was decided ...

- to impart training to all data entry operators on accounting concepts (correct posting)

- to enable automatic spell-check facility of the accounting software, and also to keep dictionary
CDs at data entry work stations

- to re-write the integrated management system (IMS) work instructions in such a way that cheque
details would never be lost in the communication process, and

- to continue with the u-chart for monitoring the day-to-day error levels.

Let’'s see what was the result of implementing the corrective actions:



[@] FBM Tools - SPC / EPC [ Six Sigma Module (www.GlobalQualityVillage.com) - [Data Editor]

(O File Reports Graphics  About - 5 X
Pri2_datafts
B Mo Col 001 Col 002 Col 003 Col 004 Col 005 Col 006 Col 007 Col 008 &
19 23-Aug-2011 626 1 0 0 1 0 2 i
20 24-Aug-2011 547 2 0 3 0 2 7
21 2h-Aug-2011 756 1 1 2 0 2 B
22 26-Aug-2011 537 0 1 6 0 3 10
=3 s 265 -z 1 = = = =
24 29-Aug-2011 425 1 2 1 1 0 5
25 I-Aug-2011 765 2 2 7 0 1 12
26
27 After Improvements
26
2 12-Sept2011 983 1 i} 0 0 0 1
30 13-Sept2011 374 0 i} 0 0 0 0
K 14-Sept-2011 1123 0 i} 0 1 1 2
32 15-Sept-2011 538 0 i} 0 0 0 0
33 16-Sept-2011 1009 0 0 0 0 0 0
34 17-Sept2011 748 0 0 0 0 0 0
35 19-Sept-2011 862 0 i 0 0 0 0
36 20-Sept2011 10486 0 0 0 1 0 1
37 21-Sept2011 8h0 1 0 0 0 0 1
38 22-Sept2011 493 0 0 0 0 0 0
39 23-Sept2011 835 0 0 0 0 0 0
40 24-Sept2011 759 0 0 0 0 0 0
41 26-Sept2011 1081 0 0 0 0 0 0
42 27-Sept2011 1257 0 1 0 1 0 2
43 28-Sept2011 1180 0 0 0 1 0 1
44 29-Sept2011 806 0 1 0 0 1 2
45 30-Sept2011 733 0 0 0 0 0 0
4R hd
| | o[
Append Row | Save { Update | Insert Row Abowve Delete Row | Column Operations | Refrash | Close |
M Record: 1 Pleaze do not edit row numbers. Software manages it by itzelf, = M

LICEMSEE: XYZ COMPANY, TRIVAMNDRUM, INDLA - 695005, |Data Server Nick Mame: Program Folder

Example Project (Service Industry)

See the freshly collected data for September 2011.




&l pata Analysis Work Book: SPC Charts and Histogram

Six Sigma Project ID: |PDDUDE jPrDjectPhase: Contral

Analysis Title: |Accuunts Data Error Maonitaring

SubTitle: |(Period: 12-30 September 2011)

Characteristic () |Cleric:al Errors keasurement Linit; |NDszecurd
Basic SFC Chart lefects/Lnit Chart Type: Comventional

Homogenisation Rule: 2 e . 1 N [(]<fal=E0 — v Diraw control charts with calour bands

Data Input T Specifications T SPC Parameters T EFC Parameters T Frocess Info.

Data File |Prj2_data.ﬂs Browse | YWiew Datafile

Data Columns:  From

Data Fows Fram Ta

Sample Size Column: <-far p. np, and u charts anly.
Maminal Walue Calumn: <- for ghort run chart epe only,

Decimal places required in numetic output: ’_4 <- between 0 and 3 only.

Option for Control Chart Limits: [Sear et | START ANALYSIS NOW |

Add New Record Goto Workhook |D -> | Save / Update ‘ Delete Fefresh ‘ Cloze
4] A |"workbook 1D: 1 [Total 2 records) kM

Example Project (Service Industry)

See the (modified) workbook entries for u-chart.




Accounts Data Error Monitoring

%

ProjectID: PO0O002 Stage: Control

LY-FIEE
ZUTT)

=y H . A4 S5 O s [l it
(FENOU. To~oU oepiETioEl U

Characteristic: Clerical Errors (Mos/Record)

u-Chart

0.0032

3 N\

00007
0.0000
1 2 3 i 5 [ 7 ] 9 10 1 12 13 14 15 16 17 18 19 20
Sample Number
MYZCOMPANY, TREIVANDRUR, INDLA - G0E005,

Example Project (Service Industry)

See the u-chart for September 2011.

CL

LCL

01-0ct-2011 14:32




{®] Control Chart Data Summary

@ Zoom [100% =

Control Chart Data Summary

General Information
Project ID

Project Stage

Process Name

dnalyst Name

Basic SPC Chart Jelected

1 POO0OZ

: Control

: Accounts Data Entry
i Atanley John

: Defects/Imit (u)

ChErt Type

Basic Statistics

From Original Data:

NMumber of Records Analysed
Sample Size [(n)

Grand Awverage

Haximum Value

Minimum Value

Six Sigma Metrics
Defects Per Million (DPM)
Sigma Quality Lewel

Tield (%)

T Comwentional

HE

: Varvihg Sample Size
00007

: 0.0025

: 0.0000

T B79.2555
: 4.7030

99,8321

Example Project (Service Industry)

See the improved Six Sigma Metrics for September 2011. Prior to Six Sigma initiatives, these were:

Defects per Million (DPM) : 8186.15

Sigma Quality Level
Yield (%)

3.90
99.18




Hope that you liked the sample project from service industry.

Now, let’'s see one example project from manufacturing industry.




Example Project (Manufacturing Industry)

The following tools are covered in this example:

- Control Chart (Variable Data)

- Scatter Plot & Regression

- Engineering Process Control (EPC)

Project Description:

In a certain pharmaceutical company that manufactures tablets, there was frequent rejection of final
product due to off-the-spec tablet weight. As part of its Six Sigma initiatives, the company’s
management decided to study the tablet weight variations by collecting some data from the plant

and analysing it.

The company has designated its Manager, Mr. Stanley John as the Project Leader and the
Laboratory Technician Ms. Ratna Raj as team member.

Now, let’'s see how this very interesting project was executed.



{@] Six Sigma Project Information Database

Froject I |PDUUU1 ¢-Erter aunique [0 Project Status:

Fieason for Project: |F’iejec’tion due to weight variations.

Project Title: |Tab|et Weight Control

Project Objective: |TD reduce weight variations.

Praject Description: This is for on-going SPC implementation on the Tablet Making machine.

Project Leader: |Stan|ey John Jab Title: |Manager

| Wiew / Edit the Ligt of Team Membersz | Wiews / Edit the Ligt of Fep Input and Output Wanables [K1W's and KOW's)

Mmejec:tsT 1. Define T 2. Measure T 3. Analyse T 4. Imprave T 5. Contral T Fesults

FrojectiD |Pruieu:1TitIe |Proie|:10biective |PrDiedReasun |PruiedDescriptiun|Pruieu:tLeaderUserID|Pruieu:
PO Tablet weight Contral | To reduce weight variat| Bejection due to weight| Thig iz for on-going SPO stanley Stanley
PoQaoz2 Accounts Data Quality 1 To reduce errars in accd Erars in alc recards ztanley Stanley

[«] |

Add MNew Record Save [ Update Delete Record

4| 4 |Fecord 1 of 2

Example Project (Manufacturing Industry)

As the first step, the project leader has created a project record by going to the menu item File >
Manage My Project Records



@] List of Project Team Members

Project|D: |PO000T

Liser D | tatna j - Select ane fram list

Marme: |Ratna Faj

Job Title: |Lab Technician

Existing List of Team kMembers:

Project| 1 | Llzer|D | LlzerMame | LlzerJohTe
FOoOo01 ratna Fatna Raj Lak Technician

Kl | >

A MNew | oave fUpdate Delete Current Record Refresh | Close |

M| 4|10f1 AL

Example Project (Manufacturing Industry)

Then, he entered the team information by clicking on the “‘View / Edit the List of Team Members’
button.



®] | ist of Key Variables {Input and Output)

Froject D PO000T

Mame of Wariahle:; |Feed Fate

Twpe: FeynputVWariable |ESillglal=leaml Critical To Cluality

Existing list of KIY's and KO4W's:

Froject!D | Wanahle Matme | Type | Impact
POOO01 Feed Rate Kew Input Wariable | Crilical To Guality

POOO01 Tahlet Meight Key Cutput Variable |Criical To Guality

[« .
Add MNew | Delete Current Record Fefresh | Close |

4| 4[10f2 4 Hl

Example Project (Manufacturing Industry)

After that, he entered the key input and output variables by clicking on the ‘View / Edit the List of
Key Input and Output Variables (KIV’'s and KOV’s)" button.



[@] FBM Tools - SPC / EPC [ Six Sigma Module (www.GlobalQualityVillage.com) - [Data Editor]

(O File Reports Graphics  About g X
ChDocuments and Settingsiws\DeskiophSPCYY Demo Dataltaklet weight fts

Fow Mo | Col 001 Cal 002 ol 003 Col 004 Col 005 Col 00s Cal 007 ol 008 -
0 Date Tirne Weight-01 Weight-02 YWeight-03 W'eight-04 Average Weight Feed Rate (<) kg/s —
1 16-Aug-2011 06.00 Hrs 0.993 0.93z2 0.933 0.9 0.9925 2.058
z 16-Aug-2011 07.00 Hrs 0.995 1.002 0933 0973 0.9aa2 2m
3 16-Aug-2011 05.00 Hrs 0.991 0.93z2 0.936 1.935 0.9334 2.02
4 TE-Aug-20H 0900 He 0991 0995 nagl 1013 09951 208
5 16-Aug-2011 10.00 Hrs 0.986 0.9s2 0987 1.935 0.9343 1.93
G 16-Aug-2011 11.00 Hrs 0.986 0.974 0.964 0.993 0.9735 1.94
7 16-Aug-2011 12.00 Hrs 0.983 0.a70 0452 IRzE 0.9789 1.493
] 16-Aug-2011 13.00 Hrs 0.9495 0.986 0.984 .99z 09918 2.0/
] 16-Aug-2011 14.00 Hrs 1.002 0.988 0.936 04972 0.9869 2.00
10 16-Aug-2011 15.00 Hrs 0.986 0.943 0.988 0.977 0.9861 2.00
1 16-Aug-2011 16.00 Hrs 0.9584 0.9: 0.935 0.939 0.9 2.0
12 16-Aug-2011 17.00 Hrs 1.000 0.9589 0.936 0.930 0.9939 2.07
13 16-Aug-2011 15.00 Hrs 0.993 0.956 0.930 0.935 0.9932 2.06
14 16-Aug-2011 19.00 Hrs 0.983 0.933 0432 01.974 0.9a871 2.00
15 16-Aug-2011 20.00 Hrs 0.9a0 0.933 0.936 [IREE]N] 0.9336 2.02
16 16-Aug-2011 21.00 Hrs 0.992 0.933 0.961 UL 0.9355 1.99
17 16-Aug-2011 22.00Hrs 0.984 0978 0432 1.934 0.9az0 2.00
14 16-Aug-2011 23.00 Hrs 0.935 0.976 0.470 .93 09777 192
14 16-Aug-2011 24.00 Hrs 0.993 1.002 0.930 1.939 0.9951 2.08
20 17-Aug-2011 071.00Hrs 0.978 0.979 0.936 1.009 0.9903 2.03
21 17-Aug-2011 02.00Hrs 0.93 0.9a2 0937 1.93k6 0.9365 2.00
22 17-Aug-2011 03.00 Hrs 0.9 0.976 0.936 1.003 0.9364 2.00
23 17-Aug-2011 04.00 Hrs 1.0112 0.983 0.935 1.939 0.9345 2.07

» E4 17-Aug-2011 05.00 Hrs 0.990 0.934 0.99: 1.965 0.9325 1.96
25
26

P 27 =
Append Row | Save { Update | Insert Row Abowve | Delete Row | Column Operations | Refrash | Close |

M Record: 25 Pleaze do nat edit row numbers. Software manages it by itzelf, == M

LICEMSEE: XYZ COMPANY, TRIVAMNDRUM, INDLA - 695005, |Data Server Nick Mame: Program Folder

- -
Example Project (Manufacturing Industry)

Then he created a data file and entered the data that was collected with the help of team member.




@] Data Analysis Work Book: SPC Charts and Histogram

Six Sigma Project ID: |PDUDU1 j Froject Phase:

Analysis Title: |Tab|et Waight Control

SubTitle: |[M,."c Mo -2, Period: 16-17 August 2011)

Characteristic () |Tab|etWeight tdeasurement Unit: |Grams
Basic SFPC Chart: Caonwentional

[ lalgelalsl=NTEI=UTUEDIEN Ston when 25% samples are droppec — ¥ Draw contral charts with colour bands

Data Input T Specifications T SFC Parameters T EFC Farameters T Frocess Info.

Cata File |tab|et_weight.ﬂs Browse | “iew Datafile

Data Columns:  Frorm

To
Tao

3
Data Fows Frarm 1 24
Sample Size Column: <-for p, np, and u chartz only.

MNominal Yalue Column; <- for shart tun chart type only.

Decimal places required in numeric output: ’_4 <- between 0 and 3 only.

Option for Control Chart Limits: [efalg{afi=R{{slyie(=1t=} START AMALYSIS NOW ‘

Add Mew Record Goto Workbook 1D -> || i Delete Refresh | Close

M| 4 |"workbook ID: 2 [Tatal 2 records] AL

Example Project (Manufacturing Industry)

After that he has created a workbook record for control chart.




@] Data Analysis Work Book: SPC Charts and Histogram

Six Sigma Project ID: |F"DDDD1 j Froject Phase:

Analysiz Title: TabletWeight Control

SubTitle: ‘(Mfc Mo -2, Period: 16-17 August 2011)

Characteristic [): |Tab|etWeight teasurement Unit. |Grams

Basic SPC Chart Xbars  [EECURIE Conventional

Hormogenisation Rule: EEie]si =T amples are dropped — v Draw contral chars with colour bands

Data Input T Bpecifications! T SPC Farameters T EFC Farameters T Frocess Info.

Technical Specifications:  User-defined Control Limits for Hean { Cvq{ HA ! CuSum { EV/MA { UBH and Variation®
v USL 104 CuUcL®*| UCL[RSMRMS]* | 000
¥ TGT 100 [~ CLE)* li ~ CL [RISMR/MS]* li
v LSL 086  LCLE&)* | I LCL[RSMRMS]* | 000

Impartant Mote: When pou opt for uzer-defined contral limits, thiz zoftware would draw the control charts uging those limits anly. Thiz iz
uzually done far real-time operator-level process monitoring, after the process iz brought under statistical control. Mormally, a senior
person [gay, the Quality Contral In-charge) computes these limits periodically from old [recent) data using thiz software and updates the

et N T = kel Bt b e | £ H sl Ol A I £ H 4 b
i EE e e Conto i T s e e e as Tegquehit s possoeE T iEas e Tead ine e fratar ror oreimorrat ok

Optiun for Control Chart Limits: [T ai8|i=tsKi alat R l=1r=1 = START AMALYSIS HOW |

Add New Fecord Goto Warkbook D - | Save f Update Delete Eefresh | Cloge

M| 4 |"arkbook [D: 2 [Total 2 recards) AL

Example Project (Manufacturing Industry)

He has then added details under ‘Specifications’ tab.




@8] Data Analysis Work Book: SPC Charts and Histogram

Six Sigma Project 10 |PDDDD1 j Froject Phase:

Analysis Title: |Tab|et Waight Control

SubTitle: ‘[Mfc Mo -2, FPenod: 16-17 August 2011)

Characteristic (v |Tab|etWeight Measurement Unit. |Grams

Basic SFC Chart: m Chant Type: (el

mIaly G ETEE RN Siop when 25%: samples are dropped ~' | Draw control chars with colour hands

Data Input T Specifications TSSPCPﬁrﬂmelersiT EPC Farameters T Process Info.

Chart Type Required Parameters [Figues in brackets are the recommended values.)

boving Average  Awg. Period (w): 2 [ between 2 and 200 anly.)
Cu-Surn Head Start : 280 [250) Reference Yalue, K {in Sigmas): 0.50 [0.50)
{in Sigmas) . -
Decigian Interval, H (in Sigmas): 5.00 (5.00)
Cu-Sum or EWyhA Target (MUo): 100 | Use homogenised process average as Target
EWhdA, FIR (Steiner's f): 050 (050  Control LimitWidth, L {in Sigmas): 270 [2.70)

Smoothing Constant (Lamda): 010 [0
[ Find 'best-fit' Lamda from process data.

Opliun for Control Chart Limits: ESalqlaBli=tsRialiiRet=1=} = START AMALYSIS NOW ‘

Add MNew Record | Goto “Workbook [D -» | Sawve / Update Delete ‘ Plefresh‘ Close

Example Project (Manufacturing Industry)

He has then looked at ‘SPC Parameters’ tab and just made one entry (Target = 1.00) and kept all
others at default values. As the basic chart selected was Xbar-S and chart type selected was
‘Conventional’, these parameters were not required. Regarding ‘EPC Parameters’ tab, he decided
to enter the details at a later stage (after analysing the data using Scatter Plot and Regression tool).



FBMTools - SPC [ EPC [ Six Sigma Module

"
g 1 ‘) Data file read in successfully, You may now open the contral chart related reports and graphics From the menu bar,

Example Project (Manufacturing Industry)

He then clicked on the ‘START ANALYSIS NOW’ button, and received the above message.

Now, he decided to see the graphs first.




Froject ID: POOOOT Stage: Analyse

Tablet Weight Control

(M/c No - 2, Period: 16-17 August 2011)

Characteristic: Tablet Weight (Grams)

Histogram

Frequengy LSL TGT usL

: <

A 1IN

/ N

; //, \

'

AL ~1 _

0.9581 0.9693 0.9315 0.9932 1.0049 1.0166 1.0233 1.0400
Tablet Weight

* Bazed on un-homogenized data. Mean & SD computed by Frequency Takle method.

LSL=09600 TGT=1.0000 USL =1.0400 N=96 Hean=09375 SO =0.0093

MAZCOMPANY, TRIVANDRUR, INDIS - 525005,

18-A00-2011 10:01

Example Project (Manufacturing Industry)

Histogram, depicting the data distribution (spread) viz-a-viz tolerance band (technical
specifications).




Project ID: POODOY Stage: Analyse

Tablet Weight Control

Mgt m ol A 4= A MY E
, CENOU. TO=T7r AUgLUSL ZUTT)

Characteristic: Tablet Weight (Grams)

Frequency Table

Class == LB = UB Mid Value Frequency
1 0.9610 0.9675 0.9643 3
2 09675 09740 0:9708 6
3 0.9740 0.9805 0.9773 10
1 0.9805 0.9870 0.9838 28
5 0.9870 0.9935 0.9903 22
6 0.9935 1.0000 0.9968 20
7 1.0000 1.0065 1.0033 4
8 1.0065 1.0130 1.0098 3

Mean =0.9875 Standard Deviation = 0.0098 N=9

1E-Ang-201110:02

AVZCOMPANY, TRIVANDRUR, INDL2 - S50,

Example Project (Manufacturing Industry)

Frequency Table (optional add-on to Histogram), showing data distribution in tabular form.




Q

Praoject ID: PO0001 Stage: Analyse

Tablet Weight Control

(M/c No - 2, Period: 16-17 August 2011)
Characteristic: Tablet Weight (Grams)
Normal Probability Plot

Cum. Probability 1.000000 +14 zvalue
0.998599 +2
0077444 +2
0841316 +1
— 0499728 o
0158454 -1
0.022702 -2
0.001346 -3
0.000032 + + + + + + + + + $ + -4
0.961 0.966 0971 0.977 0952 0.987 0992 0.997 1.003 1.008 1.013
Sorted Data 18-Aug-2011 10:03

AAZCOMPANY, TRENANDRUR, IND 12 - 525005,

Example Project (Manufacturing Industry)

Normal Probability Plot (NPP) is a very important visual aid for checking the normality of data (i.e.,
to examine whether the data comes from a population with Normal Distribution). If the data follows
Normal Distribution, the plotted points would form a straight line.



Q

ProjectID: PO00O01 Stage: Analyse

Tablet Weight Control

(M/c No - 2, Period: 16-17 August 2011)

Characteristic : Tablet Weight {Grams)

Run Chart
0.9950 A A A Haximum
09379 \// /\ / \/\ \ / e
~ V
09778 ) ) ) ) ) ) ) ) ) Minimum
1 3 5 i 9 1 13 15 17 19 21 23
Sample Number 18-Aug-2011 10:05
NAZCOMPANY, TRIANDEUR, INDIS - 625005,

Example Project (Manufacturing Industry)

Run chart is a simple plot of sample averages, which gives a visual understanding of patterns and
trends in control chart data.



Froject ID: POOOOT Stage: Analyse
Tablet Weight Control
(Mfc No - 2, Period; 16-17 August 2011)
Characteristic: Tablet Weight (Grams)
Auto Correlation Chart

Rhodk) k  Rho(k)
01 -0.0249

1.00 0z -0.1722
03 -0.0815

0.50 04  0.1395

1=} = addg

0.60 06 —-0.2190
07  0.0178

08 0.1095

040 09 0.0381
1o
000 [ 1 — 1 — 12 0 0784
i 1 T — 13 -0.1507
| |_| |_|_ —L 1 14 -0.1824

020 15 0.1408
16 -0.0899

040 17 -0.1063
18 0.0885

2060 19 0.13233
20 -0.0718

21 —0.0124
280 22 0.0529
400 23 —0.0440

M2 n W 2
Lag, k
(T COMPANY, TRIVANDRUR, INDIA - 5265005, 18-Aug-2011 10:08

Example Project (Manufacturing Industry)

Traditional SPC charts are not effective when the data is highly auto-correlated (i.e., when
consecutive data points are correlated. If the bars on the Auto-Correlation Chart are shorter, it
indicates less amount of auto-correlation. In case the data is highly auto-correlated, use
Un-weighted Batch Mean (UBM) chart.



Project ID: POOODM Stage: Analyse

Tablet Weight Control

(M/c No - 2, Period: 16-17 August 2011)
Characteristic: Tablet Weight (Grams)
Xbar Chart

1.0039

~__ \ A TN AN

e s s

09713 LCL

Standard Deviation Chart

0.0223

AN, e
4 \/\/\\/\’\/’“ — v

0.0000 , , , , , LcL

1 3 ? 9 11 13 15 17 19 M 23
Sample Number 18-AUg-201110:07

EVZCOMPANY, TRIVANDRUR, INDIS - G25005,

Example Project (Manufacturing Industry)

Control chart shows that the process is under statistical control. That means, there is no sporadic
(assignable) cause present. The process is stable.



]

Project ID: POO0DT Stage: Analyse

Tablet Weight Control

{M/c No - 2, Period: 16-17 August 2011)

Characteristic : Tablet Weight (Grams)

Normal Curve

LSL TGT UsL

09235 0.9421 0.9604 0.9757 0.9970 1.0153 1.0336 1.0519

* Based on homogenised data. Tablet Weight (Grams)

LSL = 0.9600 TGT=1.0000 USL=1.0400 Hean=09379 SD=00107 Cp=125 Cpk=0357 Cpm=032 Cpkm =057 Cpc =052
DPH = 4542.0366 Sigma Quality Level = 1066 Yield () = 99.5453 18-Aug-2011 10:08

AVZCOMPANTY, TRIJANDEUR, INDILA - 625005,

Example Project (Manufacturing Industry)

Six Sigma Metrics & Probability Distribution (Normal) gives an idea about expected rejections.
Though none of the data analysed were beyond specifications, the small red zone below the lower
specification limit (LSL) indicates possibility of manufacturing out-of-spec products.

Also, the process is barely capable (Cp < 1.33) and not centered (Cpk < 1).



@] Control Chart Data Summary.

@ Zoom [100% -

Control Chart Data Summary

General Information

Project ID : PO0OOL

Project Stage 1 Analyse

Proceszz Name : Tablet Making
Analyst Name : Stanley John, Manager
Basic SPC Chart 3elected i kbar-3

Chart Type : Conwentional

Upper Specification Limit (USL) : 1.0400

Target Walue (TGT) : 1.0000

Lower Specification Limit (L5L) : 0.9600

Basic Statistics

From Original Data:

Numher of Records Analysed

Sample Size (n)

Grand Average

Population Sigma

Maxinum Value

Minimum Value

Data Above Upper Specification Limit

Data Below Lower Specification Limit

Pages M |4 |17 (AL

Example Project (Manufacturing Industry)

Now, the reports were looked at. First, the data summary.




@ Control Chart Data Summary

@ Zoom [100% -

Data Homogenisation

Homogenization Rule : Stop when 25% samples are dropped
Ho. of records dropped Hl

Result of Homogenisation : Success

Grand Awverage [(Homogenised) : 0.9579

Population 3igma (Homogenised) : 0.0107

Statistical Process Control Limits
[Computed from data)

¥bar Chart:

Upper Control Limit (UCL)

Central Line (CL)

Lower Control Limit (LCL)
Standard Deviation Chart:
Upper Control Limit (TCL)
Central Line (CL)

Lower Control Limit (LCL)

Pages: M |4 ,17 b M

Example Project (Manufacturing Industry)

Data summary, continues.




{®] Control Chart Data Summary

@ Zoom [T00% v

Process Capability Indices

Frocess Capability (6 % Sigma)
Frocess Potential Index (Cp)
Process Capability Ratio (Cr)
Process Performance Index (Cpk)
Taguchi's Index (Cpn)

Pearn's 3G Capability Index (Cpkm)

Luceno's Non-Normal Capability Index (Cpc)

Six Sigma Metrics
Defects Per Million (DPM) 4542, 0366
Sigma Quality Lewel : 4,1066

Tield (%) : 99,5455

Pages: M |4 ,17 AL

Example Project (Manufacturing Industry)

Data summary, report ends.




&) Analysis of Runs in Control Chart Data

@ Zoom [100% -

Analysis of Runs in Control Chart Data

General Information

Project ID : POOOOL

Project Stage T ATElyEE

Process Name : Tablet Making
Analyst Name : Stanley John, Manager
Basic 3PC Chart 3elected : kbar-3

Chart Type : Conwventional

No. of Samples Analysed @ 24

Detection of Runs of Cyclic Patterns

A run-above of length 4 starts at sample # 1
& run-below of length 3 starts at sample # 5
A run-asbowve of length 3 starts at sample # 11
A& run-below of length 3 starts at sample # 16

No significant cyclic wariations detected.

Example Project (Manufacturing Industry)

Then he looked at the Control Chart Run Analysis, but couldn’t see any significant cyclic variations.
Mr. John has concluded that the real problem is in process setting. From his technical knowledge,
he knows that Tablet Weight can be adjusted by controlling the Feed Rate (input variable). But, he
needed to establish the relation, i.e., Average Weight of Tablet (Y) Vs Feed Rate (X). For this, he
decided to use scatter plot & linear regression.



@&l Data Analysis Work Book: Scatter Plot and| Linear Regression

Six Sigma Project!D: | PODO0T ~| Project Phase:

kdain Title: |Tab|et Whaight Control

ll’h.dr.l'ﬁ Mo 2 Feriod: 16-17 .&llgll t 201710

Diata File: |tab|et_weight.ﬂs Browse | YWiew Datafile |

Independent Variable (><j|:|Feed Rate Unit |Kg,ﬁ5 Data Colurnn |8

Dependent Wariable () |Avg_TabIetWeight Unit |Grams Data Column |7

Data Rowes: Frorm |1 To |24 v Show FegressionLine v Show Equation

Decimal places in output: |_4 < 1tod

General Motes:

MName of Frocess:

Marne of Analyst:

START AMALYSIS NOW ‘

Add MNew Record | Goto Wworkbook 1D -» || Delete Refresh‘ Close

4] 4 | workbook |D: 1 [Tatal 1 recards] kM

Example Project (Manufacturing Industry)

Then he created a Scatter Plot workbook.




atter Diagram and Regressio : x|

Froject ID: POOOOT Stage: Analyse

Tablet Weight Control

(M/c No. 2, Period; 16-17 August 2011}
Avg. Tablet Weight (Y) Vs Feed Rate (X)
Scatter Plot

Avyg. Tablet Weight (Grams), ¥
0.9951

0.9934

0.9916

0.9899

0.9881

0.9864

0.9847

0.9829

0.9812

0.9794

0.9777 ¢

I I I I ; I I I I I f
1.9200 1.9360 1.9520 1.9680 1.9840 2.0000 2.0160 2.0320 2.0480 2.0640 2.0800
Feed Rate {Kg/'s), X

¥ =07683 +0.1082 " X R-Sguare=09981 MN=24

18-AUg-2011 1017
HVZCOMPANY, TRIVANDRUM, IN DA - 625005,

Example Project (Manufacturing Industry)

By clicking on the ‘START ANALYSIS NOW’ button, he could se the scatter plot & regression line.
As a rule of thumb, R-square value must be at least 0.70 for the regression line to be considered as
meaningful. Mr. John looked at the R-square value. It was 0.9951 (very close to the perfect value).
So, he decided to use the equation.




Example Project (Manufacturing Industry)

Setting up an Engineering Process Control (EPC) chart for the Tablet making process:

It involved the following steps (and cues from the User Manual accompanying the SPC software):
1. Selection of feedback control model: Selected Integral model, for simplicity.

2. Setting the parameter (g) for the selected model: Overall Process Gain, g = 0.1092

3. Setting the Smoothing Constant (A) for EWMA predictor: A = 0.15 (‘best fit' from recent data)
4. Setting the Adjustment Boundary Value (L) for EWMA predictor: L = 0.0041

5. Re-setting the process average at the Target value (1.00 gram): Done by engineering means.

6. Installing an EPC chart and monitoring (and adjusting) the process: For this, he went back to the
SPC software.

Let’s see what he did there.




(@] Data Analysis Work Book: SPC Charts and Histogram

Six Sigma Project ID: |PUUDD1 j Froject Phase:

Analysis Title: |Tab|et Weight Contral

SubTitle: |(M,."c Mo -2 Period: 16-17 August 2011)

Characteristic (): |Tab|etWeight Measurement Unit: |Grarms

Basic SPC Chart Xbar-3  EICURVERE Conventional

Homagenisation Rule: ESElaR=TN: imples are dropped =~ [ Draw control charts with colour bands

Data Input T Specifications TSPCParameters TEEPCPﬂrﬂmeterséT Frocess Infa.

v Perfarm Engineering Frocess Control (EFPC) computations

Mame of Input VWarighle () |Feed Fate Ok |I<g5 { Second

Feedback Control Modal: _

Qwverall Gain (g): | 0.1092 <- This is the change in output variable [Y'] for unit increment in input variable [<]

Fropaortional Gain (Kp): Ii Integral Gain (ki): ’7 Derivative Gain (Kd): Ii

Process Target (T): li‘l EFC Smoothing Constant (Lamda): |715
—

[ Find 'bestfit’ Lamda from process data.

Adjustment Boundary Yalue (L |

Option for Control Chart Limits: [G[{sctsNigalgie =) = START ANALYSIS NOW |

Add Mew Record Goto Workbook (D -> | Save [ Update Delete Refresh ‘ Close ‘

4| o |"workbook 1D: 2 [Total 2 records) AL

Example Project (Manufacturing Industry)

Mr. John has edited the original control chart workbook (EPC Parameters tab), as above.




[@] FBM Tools - SPC / EPC [ Six Sigma Module (www.GlobalQualityVillage.com) - [Data Editor]

(O File Reports Graphics  About - 5 X
taklet_weight fts
Fow Mo | Sol 0l ol 002 Colon3 Col 004 Caol 005 ol 006 ol 007 Colong -
20 17-Aug-2011 07.00 Hrs 0978 0979 0,996 1.004 0.9903 203
21 17-Aug-2011 02.00 Hrs 0.9 n.49az2 0.997 0.936 0.9865 z.0a
22 17-Aug-2011 03.00 Hrs 0.9 1976 0.936 1.003 0.9864 z.0a
23 17-Aug-2011 04.00 Hrs 1.m2 0983 0.995 0.933 0.9945 207
24 12-Augr2i 0500 He 0990 1984 0991 0G5 [.982g 145
25
26 After process re-set
27
28 18-Aug-2011 14.00 Hrs 1.000 1.008 1.012 0988 1.0020 213
24 18-Aug-2011 16.00 Hrs 0.9 1.995 1.017 1.001 1.0010 213
30 18-Aug-2011 16.00 Hrs 1.007 1.013 0.999 0.952 1.0004 213
31 18-4ug-2011 17.00 Hrs 1.0m 0992 1.000 0.987 0.9947 213
32 18-4ug-2011 15.00 Hrs 1.005 1.002 1.012 0.995 1.00401 213
33 18-4ug-2011 19.00 Hrs 0.930 0.993 1.006 0.934 0.9971 213
34
35
36
37
35
34
40
a1
42
43
44
45
4G
47 i
| | [
Append Row | Save { Update | Insert Row Abowve | Delete Row | Column Operations | Refrash | Close |
14| 4 |Record: 1 ** Please da not edit row numbers. Software manages it by itself. = M

LICEMSEE: X¥Z COMPANY, TRIVAMNDRUM, IMNBIA - 695005, | Data Server Mick Mame: Program Folder

- - -
Example Project (Manufacturing Industry)

After process re-set, fresh data were taken from 2.00 PM onwards and entered in the same data
file as above.




&) Data Analysis Work Book: SPC Charts and Histogram

Six Sigma Project ID: |PDUUD1 jPrDjectPhase: Contral

Analysis Title: |Tab|et Weight Cantral

SubTitle: |(M,."|: Mo -2, Period: From 18 Aug 2071)

Characteristic (v |Tab|etWeight teasurement Unit. |Grams

Basic SPC Chart: m Chart Type: |[ealg¥=Ty1{u]st=]

Homogenisation Rule: EEElsRil=l) (sl CERETEN (e ls =B — [V Draw control charts with colour hands

Data Input T Specifications T SPC Parameters T EFC Parameters T FProcess Info.

Data File |tab|et_weight.f‘t5 Browse | Yiew Datafile

Data Columns:  From To G
Data Fows : Fram 28 To 33

Sample Size Caolumn: < for p, np, and u charts only.

Mominal Yalue Column: <- far ghart run chart tppe oy,

Decimal places required in nurmeric output; ’_4 <- between 0 and 3 anly.

Dptiun for Control Chart Limits: [eelalamli=1s8i a1 ahel=1l= START ANALYSIS NOW |

Add Mew Record | Goto Warkbook (D -> || 1 Delete Refresh| Close

| oA |'workbook ID: 2 (Tatal 2 records) AL

Example Project (Manufacturing Industry)

Then, the work book entries were modified (such as project phase changed to ‘Control’, etc) as
above.




Tablet Weight Control

(M/c No - 2, Period: From 18 Aug 2011)
Characteristic (Y}, Tablet Weight (Grams)
Engineering Process Control Chart

FProject ID: POOODM Stage: Control

Cantrol Model: Integral

1.0043 1 UB = 1.0041
- Target = 1.0000
LB = 0.0959
0.9950 |

[ 7 g 9 10 1 12 13 14 15
Sample Number

Lamda = 0.1500 Gain (g) = 0.1092 Target = 1.0000

Next Point Prediction = 1.0005 Control Action: Leave Feed Rate (X) at its present level.

AZCORMPANT, TRIANDRUR, INDIA - 625005,

16

17

18

19

FL

18-Aug-201119:04

Example Project (Manufacturing Industry)
Then hit the ‘START ANALYSIS NOW’ button, and checked the EPC chart (‘Graphics’ menu).

The thin graph in black colour is the sample mean. The thick graph in blue colour is the EWMA
predictor for process average. The next point prediction (predicted value for process average at
8.00 PM) was 1.0005 and the advice was to leave the Feed Rate (X) at its present level (i.e., 2.13).




We have discussed two practical projects so far.

What are you thinking now ?

Never thought that such things could be done in your organisation also !
As they say, it is better late than never.
Our software could be a helpful companion in your improvement initiatives.

This product is available in three editions (Academic / Lite / Standard).

Each edition is designed to serve a particular user category.

Let us now talk about the software features in detail.




-
@] FBM Tools -SPC [ EPC [ Six Sigma : Login

Welcome To

FEM Tools - SPC [ EPC | Six Sigma Module
ct pour User 1D fram the list

Pazzword iz caze senzitive

Login Az & User £ Admin

This is the login screen.

Select your User ID from the list, enter the password, and select a login option (User / Admin).

Then press ‘OK’ to enter the software.




[@] FBM Tools - SPC / EPC / Six Sigma Module (www.GlobalQualityVillage.com)

Z=8 Reports  Graphics  About

Cl I
» Change Workbook Owner »

4 ect Leader

5 | Start Data Analysis

The major menu items are: File, Reports, Graphics, and, About.

Under the File menu, users can create six sigma project records, create / edit data files in this
software’s own format, import data from MS-Access / Excel / Text files (also export data to these
file formats), create workbook records, and, analyse data through these menu items.

System Administrator can access various admin and set-up menu items.



&) FEM Toals - SPC [ EP. .,

Reports menu generates reports in text form, which can be printed or saved as PDF files.

Project and workbook related queries can be made here. There are many data filters which helps in
segregating only those records (related to projects you are involved in and workbook records
created by you) that you wish to view during your Six Sigma projects.

Control chart data summary and run analysis reports can also be generated through this menu.



[@] FBM Tools - SPC / EPC / Six Sigma Module (www.GlobalQualityVillage.com)
File Reports WEEy=N About

ect Diagram

ark

IZ: E
Si IMetrics and Probability Distributions  ®
Eng g

nitrol (EPC) C ar [ siskribution)

Graphics menu is the heart of this software. You can view/print graphs, or save them as PDF files.

Cause & Effect Diagram, Pareto Diagram, and, Scatter Plot are very important tools required for
most of the Six Sigma projects.

The rest of the graphical output relates to SPC control charts. Advanced users can generate EPC
prediction chart also.




[@] FBM Tools - SPC / EPC / Six Sigma Module (www.GlobalQualityVillage.com)

File Reports Graphics

Abouk FEM Tools - SPC J EPC | Six Sigma module

About menu tells about the software edition, product tracking number, contact address for
technical support, etc.

Let us now look at more details of this software.




Basic SPC Charts Supported:

Name of chart

Data

Typical areas of application

X - Moving Range
Xbar - Range

Xbar - SD

Fraction Defective (p)
Nos. Defective (np)
Defects / Item (c)

Defects / Unit (u)

1 data / sample

2 - 5 data / sample

2 - 200 data / sample
sample size >= 1
sample size >= 1
sample size = 1

sample size > 0

Chemical processes

Turning operation

Blanking process

Visual inspection (good/bad) of lot items
Visual inspection (good/bad) of lot items
Visual defects (count) of castings

Clerical mistakes (count) in data entry




Advanced SPC Charts Supported:

Name of chart Data Typical areas of application

Short run / Standardized Same as basic charts | For job-shop (small lot production)
Slopping / Tool wear 2 - 200 data / sample Where gradual process shift is inherent
Six Sigma Process 2 - 200 data / sample | For monitoring Six Sigma processes

Coefficient of variation (CV)% | 2 - 200 data / sample | Normally, in textile and jute processing

Moving Avg. - Moving Range | 1 data / sample When data is slightly auto-correlated
Moving Avg. - Moving SD 1 data / sample When data is slightly auto-correlated
CuSum 1 - 200 data / sample To detect small shifts in process mean
EWMA 1 - 200 data / sample To detect small shifts in process mean

UBM 1 data / sample When data is highly auto-correlated




Other Tools Supported:

Name of Tool Typical use

Cause and Effect Diagram Brainstorming (cause-effect mapping)
Pareto Diagram Finding the vital few defects / problems
Scatter Plot and Linear Regression To study x-y relation between variables
Histogram and Frequency Table To visualize spread (variability) in data
Normal Probability Plot (NPP) To check normality of data
Auto-Correlation Chart To check auto-correlation in data

Run Chart To visualize trends in process mean
Normal Curve To visualize variability Vs specifications
Poisson Distribution To visualize defect data distribution




Statistical Analysis and Computations:

e Summary statistics

e Run analysis (detection of cyclic variations)

e Process capability indices - Cp, Cpk, Cpm, Cpkm, Cpc (for non-normal data)

e Six Sigma metrics - Defects Per Million, Sigma Quality Level, Yield %

Engineering Process Control (EPC):

e Supports Integral, Proportional-Integral, and, Proportional-Integral-Derivative (PID) control models
e Draws EPC prediction chart

e Performs process adjustment calculations

Optional Control Chart Features:

e Can draw control charts with lines or colour zones
e Can also draw charts with user-defined limits (process monitoring mode)

e Homogenizes data with user-selected cut-off %



General Features:

e Can import data from Access / Excel / Text files

e Can export data to Access / Excel / Text files

e Supports workgroups & project management

e Includes a detailed user manual (in pdf)

e Includes sample data files for every tool

¢ Provision for FREE / paid user training on software operations (at our training facility in Kerala)

¢ Provision for SPC / EPC / Six Sigma training (in Kerala) & e-Consultancy at extra cost.

OS & Recommended Minimum Hardware:

e Operating System : Windows XP or later editions

e Computer : PC / Laptop

e CPU speed : 1 GHz

e RAM: 1 GB

e Hard Disk : 2 GB free disk space

e Screen : Color monitor with 1024 x 768 resolution or higher

e Printer : Color Inkjet / Laser printer



Edition-wise Comparison:

This software comes in two forms, namely, LITE Edition (multi-user) and STANDARD Edition
(multi-user) to suit the varying requirements of prospective buyers.

We highly recommend STANDARD edition for corporate users, and, LITE edition for small
businesses and academic users (professors teaching SPC / Six Sigma, executives preparing for
Six Sigma Green Belt / Black belt examination, etc.).

Both editions are economically priced, making them very affordable to corporate bodies as well as
individuals.

Particulars Lite Edition Standard Edition
Target user segment SMEs, Teachers, Students Large Companies
Max. records (rows) / analysis 100 10000

Max. No. of data columns 50 200

Max. No. of Users / Site License | 5 Unlimited

Product warranty & support 3 months 6 months

User training in Kerala (India) For nominal fee FREE for 1 person
No. of FREE upgrades 2 3

Migration to Standard Edition Allowed Not required




Thank you for the patience. Please see the CD pricing. = geci vaie
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Money

STANDARD Edition (Product code: S0003B) of this software
is priced US$ 199 (Indian Rupees 11400) only per site license.

Note: One site license of Standard edition allows unlimited number of users at buyer’s one site (premises). This offer
includes product support for six (6) months, 8-hours of hands-on training for one user at our training facility in Kerala (India),
and THREE major upgrades (i.e., version 7.xx to version 10.xx).

LITE Edition (Product Code: S0002B) of this software costs US$ 130 (Indian
Rupees 7400) only per site license.

Note: One site license of Lite edition allows a maximum of five (5) users at buyer’s one site (premises). This offer includes
product support for three (3) months and TWO major upgrades (i.e., version 7.xx to version 9.xx). Lite edition is generally
suitable for academic purposes and/or small organizations.

You can migrate to Standard edition by paying the price difference within 3 months of purchasing the Lite edition.

To purchase this software
just now, please visit the
secure eShop on our

29 Bhanu Lane, TC-5/674/1, Vattiyoorkavu Road

website or contact us at Peroorkada, Thiruvananthapuram, Kerala, India - 695005

this address: 24x7 Phone : +91 9846110273 Email: gqv_consultant@yahoo.com
Website / eShop : https://www.GlobalQualityVillage.com




